CLOUDING UP YOUR EMAIL
CHAPTER 1: GET A COOL SIGNATURE OR THREE

Multiple signatures may include text and pictures that are automatically added to new messages. Right click over the signature text to swap between signatures.

A signature consisting of just your first name could be used for messages to friends and family or repetitive replies where multiple instances of the full signature may become annoying or take up too much room.

Your REALTOR signature should include your complete contact information: Name, designations, hyperlinked picture, company, phone, physical address, Email and Web address, a Slogan and Broker information congruent with your license requirements.

Other custom signatures can be created for different types of audiences or different businesses you are involved in.

The REALTOR Signature: 

Thank you,

Mark Porter  
Broker Owner & CRS - Certified Residential Specialist  
1101 Morgan Lefay LN, Lewisville TX 75056 (214) 449-1022

The Personal Signature: 

Mark Porter  
(214) 449-1022  
1101 Morgan Lefay Ln  
Lewisville TX 75056

The First Name Only Signature: 

Mark (214) 449-1022

To create a new Email signature
In a new Message, Click on Signature, Signatures

Create a New Signature

Basic text - based signatures can be created just fine in this signature window.

Signature with pictures, hyperlinks etc... Use the power of Microsoft Word to create the signature and copy the signature from Word, Paste it in Outlook's signature window and save.

While pasting the sometimes the picture does not show up, go ahead a save the signature regardless. Open a new Email message to verify whether or not the picture is in fact really there. (This is a well-documented bug in Outlook). Choose a default signature while you are here.
When creating the signature in Word, use the **Picture Tools, Format** tool bar to assist you in **Compressing** the picture for Email. Use **Text Wrapping, Tight** to move the text up and around the photo. Complex signatures with multiple pictures may benefit from using a **TABLE** to keep the text and pictures organized.

**Compress Pictures**
Select the pictures and use **Compress Pictures** on the picture tool bar to reduce the picture size.

**Text Wrapping**
Select the picture and use **Text Wrapping “Tight”** to wrap the text closely to the picture.
Hyperlinking Photos
Right click the photo and click Hyperlink.
Type or paste the desired hyperlink address

Changing Hyper Link Descriptions
Right Click the hyperlink, Edit Hyperlink and edit the “Text to display:”
VCards

VCards is an electronic business card that allows the Email recipient to add full contact information into their contact database with little effort. Like Word documents end in .doc, VCards end in .vcf.

To create a Vcard

1. In Outlook Contacts or People, create a new contact record or open an existing one.
2. Click the File menu in the Contact window
3. Click Save As.
4. Choose a location to save your file and enter a file name for the VCard.
5. Click Save

It is recommended you hyperlink the VCard rather than attach it to your signature. If you use Dropbox, Save the VCard to your Dropbox Folder, Right click the saved vcf file, choose the "Share DropBox Link" option and paste the hyperlink text or better yet hyperlink a picture/VCard Icon in your signature. You can download free icons at www.FindIcons.com

If you choose to use a VCard picture or Icon: Right click over your VCard picture, select Hyperlink and paste the copied DropBox link into the hyperlink address field.
CHAPTER 2: GETTING ORGANIZED

Changing the way Outlook looks

Outlook includes multiple views to prioritize access to the information you use most often. You get a different set of panes, folders and information depending on which view you choose.

Clicking on the View button on the main tool bar in any of the areas of Outlook (i.e. Calendar, Contacts, and Inbox) will allow you to change how the information is displayed.

Consider the Folder List view like it is shown here. If you click manila folder icon at the very bottom, you will then see all types of folders in the folder list. This is convenient when you desire to quickly move from the Inbox to another folder type i.e. Calendar, Contacts, Tasks, Notes and Sent Items.

Inbox Processed

Overwhelmed by an over flowing inbox? Just like in a physical file cabinet, folders in your Inbox allow organization of information so your Inbox is not just one big pile of messages.

A file system is a very personal system. How the information is sorted and where it is stored is up to you. The most important thing to remember is you need to sort and file the information in a manner that is simple and supports easy access to the information you need.

To create a new “Inbox Processed” folder
1. Right click on Root Folder and click New Folder
2. Title the new folder with a meaningful name like Inbox Processed
3. The Content type is “Mail & Post Items” and the location will be in Personal Folders.
4. Move messages to the Inbox Processed folder when you should keep the message for “history” sake.
**Keep A Month**

Tip:
A “Keep A Month” folder with a corresponding rule to automatically place social networking messages, and other short lived messages, may go a long way to freeing up the “Inbox” for more pressing messages throughout the day.

**To set up Rules**

1. Click File, Info, Manage Rules & Alerts wizard from the Tools menu
2. Click New Rule
3. Apply rule on messages I receive, Next
4. Check with specific words in the message header
5. Click specific words
6. Add Facebook, Twitter, LinkedIn etc. . . OK
7. Next
8. Check move it to the specified folder
9. Click Specified
10. Select appropriate folder or click New
11. Click Finish

**Boosting your junk mail defenses**

The Rules Wizard is a great tool for combating junk mail. Creating a rule based on message content or specific words will allow you to filter out junk messages that have made it through a servers junk mail filter. Be careful when establishing rules. Too strict of a rule can sometimes cause a message to be inadvertently discarded. Review your deleted items folder on a periodic basis.

**Drag and Drop messages to create Contacts, Calendar Items and Tasks**

Now that your Inbox Folders are set-up, you want to “drag and drop” messages to the other folders to automatically create new items. Or you can use rules to deliver messages to the appropriate folder automatically. Rules can be set to distribute messages from specific senders or about specific subjects to the appropriate folder.
CHAPTER 3: EMAIL ATTACHMENTS, EMBEDDING & QUICK PARTS

Attachments

Files may be embedded or attached to email messages. Attachments may raise a cause for concern because of their potential for transferring viruses. An embedded item is inserted into the text or body of the Email message. In either case, emailing unrequested messages that are larger than 500k is considered rude. You may end up annoying someone because you jammed up their inbound messages while they are trying to receive an important message that was requested. In any case messages larger than 5MB may fail just because of inbound server limitations.

Another common issue with attachments is incompatibility. If you send out a flyer that was made in Publisher and recipient does not have publisher, they may not be able to open it and you could end up annoying the recipient.

To Attach a File or Picture to a Message

1. Create a **new message**.
2. Click **Insert** or the insert attachment with the **paper clip** icon.
3. **Navigate** and **double click** the file you want to attach.

Sending PDF files

Not everyone has the same software programs or applications on their computers. You may find that you have created a document in a program such as Microsoft Excel or Publisher and your recipient cannot open the document if you were to send it “as is”.

The easiest and cheapest way to convert a file to PDF is using [www.CutePDF.com](http://www.CutePDF.com). CutePDF allows you to create professional-quality documents in the popular PDF file format. Documents are converted into the PDF format using the **print** command from any application. The CutePDF print driver and a free converter is available for download at [www.CutePDF.com](http://www.CutePDF.com)

To convert to PDF File

1. Select **Print** from the **File** menu
2. Select **CutePDF** from the printer drop down box
3. Click **Ok**
4. The CutePDF **Save As** window is displayed
5. **Name** the file
6. Click **Save**
7. **Attach** PDF file to email message
Consider embedding the flyer directly into the e-mail message.

1. Open a pdf file
2. Click the **Snapshot Tool**
   a. **Adobe Reader**: Click Edit, Take a Snapshot
   b. **Adobe Acrobat**: Click Tools, Select & Zoom, Snapshot Tool (for Mac Users: Shift + Command + 4 will take a snapshot of PDF)
3. Draw a box around the flyer
4. Paste the flyer into an e-mail message
Saving Re-usable Text and Pictures to Quick Parts

1. Highlight the text you want to save.
2. Choose the Insert Tab option and the Select Quick Parts button.
3. Select Save Selection to Quick Part Gallery

4. Enter a name for your Quick Part text in the “Name” field (4 or more letters) and Click OK to save.

5. Now when you create new message and want to use your saved Quick Parts text, simply start to type the name of your Quick Parts text in the body of your message. You will see your Quick Parts file Name displayed along with an option to Press Enter to Insert. Press the Enter key and the text will be automatically pasted in the body of your message.
CHAPTER 4: CONTACT MANAGEMENT

Methods for selecting a Real Estate agent

Statistics from the NAR Profile of Home Buyers & Sellers indicates that . . .

- _____ % of buyers would use the agent again
- _____ % of sellers used the agent previously
- _____ % FRIEND, RELATIVE or NEIGHBOR!
- _____ % of Sellers contacted one agent

The #1 Reason to use a contact manager: _______________________

The value of staying in touch

As mentioned above, the #1 place a Seller or Buyer looks for assistance is with someone they know-a friend, relative or neighbor.

How are you going to stay in touch?

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________
MOST POPULAR GENERIC CRM IN REAL ESTATE: MICROSOFT OUTLOOK

A contact manager is software that combines:

- Database
- Schedule
- Tasks or To-do’s
- Memos & Notes
- Word Processor

Contacts can be displayed in a variety of views.

To Change the Contacts View in Outlook

Select Contacts, Change View, Phone, Categories

In Phone List view, contacts are displayed in a table format. Each contact is assigned its own row, with columns corresponding to the fields in the contact data.

Helpful hint:
Clicking the minus sign collapses the contacts under the group header and the minus sign changes to a plus sign.

To display the contacts in that group again, click the plus sign to the left of the group name.

Right Clicking over the category header gives you a helpful “Collapse All” & “Expand All” choice.

Sorting Contacts
To quickly sort by a single column, click the Column Header

For a more detailed sort:
1. Right click the column header
2. customize current view
3. Click Sort
4. In the Sort items by box, click a field to sort by.
Adding Columns to the View

To increase the information available in a view, add columns to the view. You may also change the order of the columns in the view.

To add or change the columns in the view
1. Right click the column header
2. Select Field Chooser
3. Drag the desired field to column position.

Example of changing the columns to view
**THE CONTACT RECORD**

The contact manager can be a valuable tool if it is updated with current information. All clients, prospects and associates should be added to the Outlook contact database.

To create a new contact record

On the **File** click **New, Contact**, Enter the information you want to include for the contact.

If you have more than one address for a contact, to establish which address is used during mail merge, select **This is the mailing address** check box.

Click “**Save or Save and Close**” if finished entering Contact information.
The Importance of Categories

In addition to entering the usual information about a person (name, address, phone numbers, etc.), Outlook allows you to place several contact categories on a contact’s record. Categories describe the manner in which contacts are grouped according to classifications such as Business, Personal and so on. A category could be “buyer”, “seller”, “referral agent”, or “yard maintenance” for example. These categories are important in providing flexibility for target marketing. You can use Outlook’s default categories or you can create your own categories.

To assign a category in the Contact window

1. Click the Categories button on the Contact tool bar.

2. Select or Clear the category check box(es).

A Timesaver: Right click the contact, click categories on the shortcut menu.
The Activities Area

At the bottom of the contact record and an e-mail message, is the activity area. A powerful feature in Outlook is the ability to track your activities associated with each contact.

- You can create a journal entry to track the length of time you spend dealing with a contact, and you can take notes during this entry.
- You can also schedule meeting with this contact and assign tasks to a contact.
- All journal entries, meeting, and tasks associated with a contact appear on the Activities tab in the Contact window.
- The activities tab also tracks Email correspondence between you and the contact.

Journal entries are handy for tracking the amount of time you spend dealing with a contact.
Add Facebook and LinkedIn integration

To add social network activity and updates to your contacts, click on an email in your inbox.

1. You will see a yellow bar (as shown below). Click on the “Connect to social networks to show profile photos and activity updates of your colleagues in Office. Click here to add networks.”

2. Select the networks you’d like to add.

3. Login to your social network account to connect to Office (as shown below).
CHAPTER 5: PERSONALIZED MAIL MERGE

You can use your Outlook Contacts folder as the data source for the mail merge, providing the names and addresses that will be merged into the main document.

You can choose which contacts will be part of the mail merge in three ways:

- Select contacts from the Contacts folder by clicking them while holding down the CTRL key.
- Create a separate contacts folder and copy only the contacts you need to that folder.
- Create a custom view of the Contacts folder. For example, you can create a view that contains only your contacts from a particular state/province and then send a custom Email message to them only.

Note: Outlook will ignore Personal distribution lists in a mail merge.

To send a personalized mail merge Email to Contacts

1. Click Contacts and Select the desired contacts to include in this mail merge.
2. Click (Home) Mail Merge

3. Choose Merge to: Email & give your Message a Subject Line.

4. Click Ok and Microsoft Word opens, displaying a new document with the Mail Merge toolbar.

5. In the document, type in a salutation such as “Dear”

6. Put a space after “Dear” and click the Insert Merge Fields button and insert the “First Name” merge field.

7. Click Finish & Merge

Note: Remember the anti-spam rules governing Email. You may send out commercial Email soliciting business if the Email is clearly labeled as a solicitation for business and allows recipients to opt out of future mailings. Check the REALTOR.org for updates to anti-spam rules.
CHAPTER 6: ONE EMAIL ADDRESS FOR LIFE™

What are the e-mail addresses you are using today?

What is your Cool-Branded e-mail address?

- Choose, purchase and utilize a “COOL” branded domain name.
- Use the domain name to create permanent Email addresses that supports your brand and enhances the ease of use for the consumer.
- Move away from using third party unprofessional appearing Email addresses such as AOL, Hotmail, Verizon, Yahoo, MSN, Gmail, etc . . .

An important component of E-marketing is your Email address. Every Email you send is advertising a website. Hopefully that website is yours. Furthermore, do not be held hostage by an Internet Service Provider or anyone else or company for that matter. Have one primary domain name with an associated Email address. Use that Email address for personal and business.

The easiest way to create one Email for life is to purchase a domain name. The most important domain name you buy is your own name. Purchasing a domain name is simple and can be inexpensive. By registering for a domain name, you get a unique Email address that will not change if you switch your Internet service provider, move to another state or change companies.

One of the best overall sites to purchase a domain name is the domain registrar, www.GoDaddy.com. A domain name costs around $11 per year, includes free domain forwarding and a free email account with each domain name. It is one of the best values and has relatively exceptional technical support.

Go Daddy.com lets you search to see if your name is registered as a domain. If the domain name is already registered, godaddy.com will suggest alternatives to the name you requested; usually different extensions such as .net or .biz. After registering your own name, you may want to register other domain names.
What domain names to purchase first

Sphere of Influence Friendly          Search Engine Friendly
__________________________________________  ______________________________________
__________________________________________  ______________________________________
__________________________________________  ______________________________________
__________________________________________  ______________________________________

An effective domain name that is conducive to attracting strangers on the internet through a search engine like Google might your city name, state initials and the words real estate i.e. “Dallas TX Real Estate.” I am sure no matter what community you may be in, the ideal domain name for search engine purposes is likely already snatched up. Try adding a word or two but stick to more popularly searched terms. www.MarkSellsDallasRealEstate.com includes the key words such as Dallas Real Estate for the search engines but adding a few words that make sense like “Mark Sells” might be the only available for your market place.

An ideal core domain name for branding is FirstNameLastName.com i.e. MarkPorter.com. This will likely be used as the domain name you brand with. You will make an e-mail address at this domain but no other.

Consider that a stranger may have first found you through Google by searching by city, state and “real estate” but after working with you they are likely to become more familiar with your name. Over time and depending on your branding strategy they are more likely become familiar with your name over their initial search engine terms that produced the lead in the first place.

When going through the actual purchase process, be careful. Your domain registrar will likely have a compelling sales pitch for buying extra services that just may not be necessary. Try to secure the domain name only. You can always go back and purchase anything you find you might need later.

NAR Trademark Restrictions on domain names

Since the term “REALTOR®” is a registered trademark of the National Association of Realtors (NAR) there are some restrictions on its use in a domain name. FirstNameLastNameREALTOR or www.MarkPorterREALTOR.com is generally the only acceptable use of REALTOR®. You can view NAR’s latest position on the appropriate use of the term REALTOR® at http://www.realtor.org/letterlw.nsf/pages/mmmPartTwo#TwoIII
**POP Account versus Microsoft Exchange Account**

- **POP Email**
- **Exchange**

---

©Mark Porter Inc. 2002-2015  
www.MarkPorterLive.com  
3/30/2015
Microsoft Outlook client software was inherently designed for a single user on a single computer, POP type services. Keeping multiple POP accounts in sync on multiple computers is problematic. Microsoft Exchange Server Services once reserved for those companies with the means and staff for an in-house network with a dedicated mail server. Now that internet speeds are capable, we all can have accesses to our data file with multiple devices kept in sync.

Exchange server services are so prevalent that they are now included as a part of the latest version of Office, Office 365. Now all of your Calendar, Contacts, Notes, Tasks and Mail Folders stay in sync on multiple computers, smartphones and tablets. Outlook any other way is just too much work.

Although the initial setup of Exchange Services can be difficult for the non-technical, once setup, setting up an e-mail account on your devices is all automatic. All you need is your e-mail address and password.

*Microsoft Office 365 also known as Office 2013*

Purchase Office 365 Business Premium for $150 per year at [www.Office.com](http://www.Office.com)
Steps to Implement Outlook Exchange

1. **Backup all data** associated with email, contacts, calendar, tasks and notes on all devices including computers, tablets and smartphones. Changing the Domain Mail record can eliminate web access to existing data associated with your domain email address. Before changing over the mail or MX record to Office 365, backup all existing data!

   This is the time to clean and merge your data or abandon old databases and end up with one “clean” final database to bring into your new Outlook data file.


3. Add your branded domain name e.g. “CastleHillsRealEstate.com” to Office 365 “Domains.”

4. Create a **User** e.g. “Mark” with the branded email address in Office 365 e.g. **Mark@CastleHillsRealEstate.com**

5. **Install Office 365 on one computer** and add a new profile and email account with your new exchange email address and password

6. In your new Outlook profile, import your cleaned data and double check data for any indication of incompleteness or anomalies

7. Leave Outlook open overnight to allow Outlook to **completely sync** to the cloud and index the Outlook data on your hard drive

8. Install Office 365 on other computers and allow Outlook to sync and index overnight

9. Empty your Smartphone and Tablet of email accounts, email contacts, calendar, tasks and notes

10. Add your new exchange account to your smartphones and tablets, and set the desired sync settings

**To add a new Email account to Microsoft Outlook**

1. On the **File** menu in Outlook, click **Account Settings**.

2. Select **New, Exchange** and then click **Next**.

3. Under **User Information**, type your first and last name, email address (upper & lower case) and **Password**, and click **Next**.

4. You have the option of having Outlook remember your password by typing it in the **Password** box and selecting the **Remember password** check box.
Notes: It may take a few hours before the email address will work if you just created the account at the Registrar or website provider.

Droid
1. Settings
2. Accounts & Sync (All accounts are in the same place)
3. Add account, MS Exchange
4. Add Email, Password, Next, Save.

iPhone
1. Open Settings,
2. Mail
3. Add Account, Microsoft Exchange
4. Add Email & Password, Next, Save.

Mail Forwarding

Gmail Mail Forwarding

Login to your Gmail Webmail account, click the Options logo in the upper right, Mail Settings, Forwarding and POP/IMAP, Add a Forwarding Address, type your **COOL e-mail address** into the field, Next. You will receive a confirmation code by e-mail at your COOL e-mail address.

Importing mail from GMAIL to Office 365 using OWA and Connected Accounts

[http://youtu.be/1LfWvglLWgP](http://youtu.be/1LfWvglLWgP)
Yahoo Mail Forwarding

Login to your Yahoo Webmail account, click Options (upper right), Mail Options, Pop & Forwarding, pay the upgrade fee for Mail Plus and type your COOL e-mail address into the Forward To field. Or, skip the Mail Plus fees and type a “Vacation Response” message to your Yahoo e-mail address users, telling them you your cool e-mail address.

Hotmail Mail Forwarding

Login to your Hotmail Webmail account, click Options on the upper right, More Options, Email Forwarding, Forward your mail to another email account, type in your COOL email address and click Save.
Verizon Mail Forwarding

Login to your Verizon Webmail account, Click **Settings, Email Settings, Forwarding, Forward All Email**, enter your **COOL email address** in the Forward email to field, enter the **address again** and click Save.

Franchise Mail Forwarding

Your email address is **markporter@kw.com**. From this page, you can set up this email address to forward to any other email address. This is useful if you have a personal email address that you use, or want to consolidate your email accounts.

**Forward to:** Mark@MarkPorterLive.com

OR

**Stop Forwarding**

Login to **MyKW.com**, click **Technology, KW Email, Forwarding**, enter your **COOL email address** and click **Change Forwarding**.
Delegating Access to a Teammate or Assistant

Mark Porter

general
mailbox usage
contact information
organization
email address
mailbox features
member of
MailTip

mailbox delegation

Send As
The Send As permission allows a delegate to send email from this mailbox. The message will appear to have been sent by the mailbox owner.

+ -

DISPLAY NAME

NT AUTHORITY\SELF
Carol

Send on Behalf
The Send on Behalf permission allows the delegate to send email on behalf of this mailbox. The From line in any message sent by a delegate indicates that the message was sent by the delegate on behalf of the mailbox owner.

+ -

DISPLAY NAME

Carol Francis

Full Access
The Full Access permission allows a delegate to open this mailbox and behave as the mailbox owner.

+ -

DISPLAY NAME

Carol Francis
Backing-Up Outlook

Even if you use exchange, you should backup Outlook.

If you accidently delete your exchange contacts via your smartphone, it can be very difficult to recover deleted contacts. In most cases deleted exchange emails can be recovered at Office.com but not contacts. At Mark Porter Live we back each exchange account via PST export monthly.

1. Open Outlook and Click File
2. Open & Export
3. Import/Export
4. Export to a file
5. Next
6. Outlook Data File (.pst)
7. Next
8. Select the root folder to backup
9. Keep “Include subfolders” selected
10. Next
11. Browse to an appropriate location for the PST file e.g. Desktop
12. Name it e.g. 021515 Mark’s Outlook Backup.pst
13. OK
14. Select Allow duplicate items to be created
15. Finish
16. Password protect the data file if desired
17. OK

Common items that are not saved in a PST file export: Rules, Views, Signatures, Safe and Blocked lists and AutoText/Quick Parts

A great resource for more details: http://hosting.intermedia.net/support/kb/?id=1424
Action Item Priorities

1. _____________________________________________________________

2. _____________________________________________________________

3. _____________________________________________________________

4. _____________________________________________________________

5. _____________________________________________________________

Thank you for taking this course. We hope you have learned tools to help you succeed and prosper.

Book Mark Porter for your next event Contact:
Carol Francis Carol@MarkPorterLive.com (972) 395-9814
www.MarkPorterLive.com 1101 Morgan Lefay Lane, Lewisville TX 75056

Any trademarks other than the Mark Porter Inc Trademark, displayed or referenced in the Mark Porter Live course materials, are the property of their respective owners.
Thanks for attending! Hope you'll join us again for one of the many other courses we offer…

**Working in the Cloud:** Instant access to all your files all the time, from home, the office, or on the road — what’s not to like? Cloud computing lets you keep all your digital stuff in sync … and just a click away. Whether it’s e-mail, property data, photos, or anything else, learn how to use cloud computing and paperless systems to be more responsive to customers’ needs. Never again be caught without the info you need!

**Get Tech Smart:** Smartphones, Notebooks and Tablets - Learn what to buy along with the coolest tips for today’s mobile agent. Understand the “need to know” when it comes to practical wireless technology for working on-the-go and keeping your information safe. Plus, put your technology to work with the latest and greatest apps in real estate!

**Attracting Today’s Internet Buyer:** Are you ready to commit to a good website? Discover the five critical things your website must have and the one fatal mistake the causes the ultimate buyer to keep surfing right past your real estate site. Learn how Search Engine Optimization and Pay-Per-Click advertising work, how to drive your website to the top of search engines, and learn all about free tools that will help you develop your SEO strategy and manage your online reputation.

**Clouing Up Your Email in Office365:** Learn the latest and greatest features of Microsoft Outlook in the all new Office365! Discover the benefits of replacing your current contact manager with Microsoft Outlook and moving your email into the CLOUD! More income with less effort! (CRS elective credit available & also available as 8 hour hands-on)

**Video Internet Marketing:** Today it’s all about video. Understand the growing trend towards video based search results and the need to catch up to your competition with video in real estate. You’ll learn how to get started with an internet presence in YouTube, SEO tips for video, and how to establish yourself as an expert in real estate with video. Plus, learn 7 ways you can start using video TODAY along with cool tips for the camera-shy agent!

**Profitable Social Media:** Are you tired of not seeing any results from Social Networking? Get the Social Media “Rules of Etiquette” that will help you see actual results from Facebook, Twitter, YouTube, & Blogging. Get tips on how to establish yourself as an expert in real estate while not annoying your sphere and you’ll get from lead generation to conversion and on to closing faster than ever. Make the shift from social network Time Killer to Profit Maker!

**Get Back to Work or Get Out!** Better systems bring more peace and confidence. Peace, Confidence and Systems translate into more listings, happier clients and ultimately bigger profits. Whether you are flying by the seat of your pants or you feel like you have it pretty well together, you can benefit from an extra proactive review of your systems. Benefit from a guided interactive discussion on what is working, why and how you can make it better. Get the guidance you need to translate your goals into action plans!

**Budgeting for Profit:** Discover the key elements to building a profitable real estate business through modeling successful agent benchmarks. Tips for building your budget the right way - how to pay yourself first, hold expenses accountable and track your marketing efforts. Today’s budgeting tools that will help you create easy systems for budgeting and profit!

1 day Course:

**CRS Building a Team to Grow Your Business:** Even the most talented and dedicated agents have limits on what they can accomplish alone. To take your business to the next level once you’ve reached a plateau, you’ll need to hire some help. Whether you are a solo agent wanting to close more transactions or a rainmaker looking to increase your team’s market share, hiring the right person can help grow your business. This course offers strategies for delegating and outsourcing tasks to help you focus on activities that make you the most money.

2 day Courses:

**CRS 200 Business Planning and Marketing:** Successful real estate agents know how to run a business. They know how to define their goals and have the business planning, budgeting, and marketing skills to get them where they want to go. After taking this course, students will know how to think like a business owner, with the ability to develop a complete business plan with strategies they can implement immediately.

**CRS 206 Technologies to Advance Your Business:** This course guides students through a process for analyzing the technology needs of their business. Course topics focus on using technology tools that enable sales agents to become more productive, increase their profits, and differentiate themselves in the marketplace.